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Powerful
PowerPoint
charts

Easy instructions for creating
and editing Gantt-, world map-
and more charts

The Ultimate Guide




Visualize your data with
PowerPoint charts

This ultimate guide to PowerPoint charts includes a list of the most
popular chart types, and instructions on how to create a Gantt chart
and a world map chart in PowerPoint. We also show you how to
keep your chart data up-to-date by linking charts to Excel spread-
sheets. Finally, you learn some tips on how to design and format
your charts.

We hope to give you powerful know-how about PowerPoint charts
to make daily work a little easier.

empower




Our Mission

We at empower® know Office like the back of our hand. We've spent
years, day and night, learning the Office apps’ strengths and weak-
nesses. That's why we started to revolutionize daily life with MS Office
in 2005. We develop solutions that enable people worldwide to work
with Office more easily, consistently, and efficiently. Our mission is to
help users get the best results quickly so they have time to focus on
their professions and to be their best at work.
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A List of the most useful
PowerPoint charts
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Do you wonder which PowerPoint chart is most suitable for your pur-
pose? There are a variety of chart types, such as Gantt charts, Mekko
charts, waterfall charts, area charts, etc. With the right representation, you
can support the meaning of your data and communicate it successfully.
Here we list the most useful charts and explain what purposes they suit.
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Not every PowerPoint chart is
suitable for every data set

The challenge: integrate complex, dry figures into the narrative so your audi-
ence can follow the story. If you only project unprocessed reports on the wall,
you will inevitably lose the reader's interest. Therefore, make sure you use the
right chart. Choose a chart that clearly and accurately explains your infor-
mation.

= What message do you
want to convey?

= What kind of data are

Ask yourself the you talking about?

following questions: " Am | presenting corre-
lations or develop-
ments?

= How many variables
are needed?

= How many data points
should be presented?
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Create PowerPoint charts in one
minute

The following 5 steps will show you how to create every chart that is in
the native Power-Point version — in less than a minute.

In the ribbon, Choose ,chart’ Click on a chart

click on ,insert’ from the list

Click ,OK' to

Choose a insert your chart

specification to the slide
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Bar and column charts

Bar or column charts are suitable for showing fluctuations and trends over a
period of time. Size ratios in particular are best compared with bars or col-
umns. Present multiple data series as either stacked or clustered col-
umns/bars. With empower®, you can decide whether to display sum labels,
connecting lines, and percentages. If needed, you can insert arrows or breaks
to highlight key points in your data.

Chart Title
6
Example: a
This diagram type is especially suit- 3
able for evaluations, or statistics. 2 I I I I
1
. Category 1 Category 2 Category 3 Category 4
B Series 1 M Series 2 Series 3
Chart Title
T —
Example:
Bar charts are frequently used in caregory 3 [
surveys. Percentages and rankings
are best visualized with bars.
|

Series 3 M Series 2 M Series 1

With empower® charts you can decide whether to display sum labels, con-
necting lines and percentages. If needed, you can insert arrows or breaks to

highlight the key points of your data.
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Pie chart

Pie charts show proportions of a whole. You can show absolute

numbers, percentages, or labels in a pie chart. Time sequences are
not suitable for pie charts.

Sales

mstQr ®2nd Qtr 3rd Qtr  m4th Qtr

Example: This chart type is mainly suitable for election results, market shares, etc.
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Line chart

Line charts (also curve charts) present events and values over time. They also
illustrate developments and trends. Several graphs can be compared directly
with each other. The axis scale can be defined and the lines formatted.

Chart Title

Category 1 Category 2 Category 3 Category 4

—Cerjeg | —Cerjes 2 Series 3

Example: This chart type is suitable for example for stock prices.

10
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Area diagram

With an area chart, you can visually represent relative references of two
quantities and how they change over time. This PowerPoint chart is especially
good for visualizing operational and strategic gaps.

Chart Title

05.01.2002 06.01.2002 07.01.2002 08.01.2002 09.01.2002

W Series 1 M Series 2

Example: This chart type is mainly suitable for sales and profit lineup.

I
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Waterfall diagram

In a waterfall diagram, growth factors or possible cost savings can be clearly
visualized in step form. Waterfall diagrams are helpful if you want to visualize
single steps of an increase or decrease during a process.

Chart Title

B Increase M Decrease [ Total

180

160
70 140
140 130
20 -40
. R

120
10

100

80

60 -60

40
20
0

Example: This chart type is mainly suitable for total costs divided into individual
costs.

With empower® charts you can easily create waterfall charts. For example,

you can easily insert subtotals per data series and display multiple waterfalls
in a single chart. You can also create waterfall charts backwards.
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Scatter diagram

Scatter plots are useful when you want to visualize a large amount
of data. They help show correlation and distribution analysis to re-
veal exceptions or outliers. Plot points with two dimensions in a
scatter plot or add a third dimension using a bubble plot.

Y values
4
3,5
3 o
2.5
2z
1,5
CI'IS .
0 0,5 1 1,5 2 2.5 3 3,5

Example: This diagram type is mainly suitable for visualization of a data
collection (for instance, speed of a car and braking distance).

13
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Mekko diagramm

Mekko charts (Marimekko and Column Mekko) are also suitable for displaying
a large amount of data. Let's say you want to show how your company's
sales distributed by segment and region in percentage terms. A simple chart
would not show the relationship of the regions to each other. For this you
need the Mekko chart.

The mekko diagram is named ,Treemap’ in native PowerPoint,

Chart Title

Example: This chart type is mainly suitable for a snapshot of several market seg-
ments in a single chart.

With empower® charts you can create original Mekko charts like Marimekko

and even Column Mekko also directly in PowerPoint.
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Radar chart

The network diagram (also known as radar diagram) is particularly suitable

for displaying the relative strength or expression of predefined criteria. Each
criterion has its own axis, the zero point of which lies in the center.

Chart Title

01.05.2002
35

30

2

A0

01.09.2002 0 01.06.2002

01.08.2002 01.07.2002

Example: This chart type is especially suitable for comparing two compa-
nies or departments based on several criteria.

15
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Combined diagram

Combined diagrams include two different chart types such as column chart
and curve chart. This type of diagram is great for presenting the relationship
between two data series with different scales. You can also use two value ax-
es to combine differently scaled data series in one chart.

Chart Title
6
5
4
s L

] [ ]
0

Example: This chart type is mainly suitable for sales, costs, and profit over time.

16



Creating a world map in
PowerPoint

Would you like to create a world map in PowerPoint? Unfortunately,
external map templates are usually inconsistent, difficult to format,
and costly to buy from stock suppliers. We'll show you how to insert
and customize a world map in PowerPoint easily and free of charge.
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PowerPoint contains an integrated
world map

Many people don't know that PowerPoint already contains an integrated
world map function. The world map is available as a free PowerPoint chart in
Office 2019 / Office 365. You can use PowerPoint maps to visually illustrate
data by coloring, highlighting, and formatting individual countries or the en-
tire world. You can even focus on specific regions / states, cities, and post-
codes.

What can the PowerPoint Maps do?

Sie Do you need to highlight or compare a country or district color? A PowerPoint “filled map” (a
combination of a chart/diagram and a map) can illustrate geographic data at a glance. Whether
the expansion of your company into new countries or your products’ trade routes, a PowerPoint
world map clearly and engagingly conveys information quickly.

Microsoft Office requirement:

PowerPoint mapping requires at least Windows 10 and Office 2019 or Office 365.
In addition, an Internet connection is required to create or update maps. However,
simply viewing a map works without a connection.
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How to add a world map to your
slide:

Where do you find the PowerPoint world map feature? It's not obvious —
PowerPoint considers maps to be charts:

5 Animations Slide Show Review View Help OfficeSpy L search

Insert Chart T = |
b S

All Charts
Icn

iong =) Recent
] Templates ﬂ
lBn Cotumn
e Line Filled Map
® rie _
B Bar |

EdEEGHRVEB|E $

oK cancel

1. On the PowerPoint Ribbon click on the “Insert” tab.
2. Click "Chart” to open the Insert Chart dialog.
3. Click on "Map” in the All Charts list.

4. Click OK to insert a general world map into your PowerPoint presentation.

19
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Enter your values in the Excel table:

Chart Title 1 Seriesl
2 United St: 8
3 Mexico 10
4 Brazil 7
5 |Argentina 9
6 Australia 12
: 7 China 11
\%" 8 Russia 8
’ " | 9 lindia 9
10 Sweden 6
11 France 7
12 United Ar: 9
‘ ‘ 13 Namibia 1
14

As soon as you have inserted the world map, a diagram and a default Excel
table with different countries and example values appears automatically. Use
the Excel table to insert, change, and delete countries and values. You can
view and adjust the corresponding values in the Excel column “Series 1”. Your
world map automatically changes the color shading of individual countries as
soon as you change values in the Excel table.

Click on the X 'in the upper right corner of the Excel table to close it.
You can reopen the Excel table any time by right-clicking the map and

choosing “Edit Data”. Or you can choose “Edit Data” from the Chart Tools >
Design tab on the PowerPoint Ribbon.

20
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Map variations

You can choose different types of maps, for example you can focus on Ger-
many or any other country in the world. If you select a specific country, you
can highlight large cities, regions, or areas by postcodes, e.g. Great Britain,
New York State, Manhatten etc. or Los Angeles, London etc. Cities and re-
gions can only be mapped on the same level. You can simultaneously map
the cities London and Glasgow, for example, but not London and Wales.

The following is an overview of the different display options of your Power-

Point map.

View: World Map
= Countries

= Regions

= Large cities

View: Country

= Regions / federal states
= Large cities

= Postalcodes

View: Regions / Federal States

= Postcodes

View: Postcodes
No further subdivisions are possible

Diagrammtitel

21
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Limitations:

As the world map function is still relatively new, there are still some limitations
and room for improvement:

You can only choose a total of twelve countries per map diagram that you
want to display. The value table only takes up twelve lines. Tip — Excel's
map function can record more than twelve values and can easily be in-
serted into PowerPoint as a map.

Specifying postal codes only works in a few countries (USA, Great Britain,
France, and Germany). However, when using postal codes the whole
country is displayed, so highlighting individual post codes will be much
too small to see properly. The exception to this is the USA, where the 50-
state PowerPoint map allows you to format things at the state level, which
are then clearly visible.

Geographic data like cities can sometimes cause an error message. Try
replacing all city data with postal codes to resolve this problem.

You can only create maps when connected online. But once a map has
been created, you can view and edit it offline. However, if you are offline,
you can't add new countries.

PowerPoint maps can hang or crash PowerPoint. Stability issues arise
mostly when there’s a slow Internet connection, or you click around too
much to highlight different countries. PowerPoint maps are far from unus-
able, but make sure you save regularly.

22



In 8 steps to a Gantt chart

Development

Dew-Start (2/2/2000) Dev-St0p (4/50/2000)
* *

A Gantt chart displays a chronological order of activities. This meth-
od is especially suited to plan projects and to generate a visual time-
line. In this Office tip we want to show you how to create a Gantt
chart in Excel in 8 steps.
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Gantt chart guide

1. step:

Create a table that displays the exact outline of your project. We recom-
mend that you enter all task stages of your project incl. start date, dura-

tion and end date.

2. step:

Insert Page Layout Formulas Data Review
7—:] g{,cm Calibri n A | E=E e
Paste B Copy. - I U = & === |
2 ~ Format Painter ot = CATEE=EE
Clipboard [ Font [} ;
A3 v | fe | Tasks
. A B e || ® E |
1
2|
3 |Tasks StartDate  Duration End Date
AJRequirements 01/01/2018 1 Week 01/07/2018
5 |Draft 01/08/2018 1 Week 01/14/2018
6 }Implementation 01/15/2018 1 Week 01/21/2018
7_i|nspecticn 01/22/2018 3 Days 01/24/2018
a;, Servicing 01/25/2018 2 Days 01/26/2018
9 i'Release 01/27/2018 2 Days 01/28/2018

10|

Add the complete time span of your project to this table. To do so, enter
the individual dates as table headers.

B -2+
File Home Insert Page Layout Formulas Data Review
s - =
\ g"c“‘ Calibri In A& x| E=E%
5B Copy ~
Paste ~ | METES v v | =E=E=|s
v ~ Format Painter BRIgU e ) A =E=E=E|E
Clipboard ] Font 11 )
€4 [ F
( A B e D \ E
17
2
3 |Tasks StartDate Duration End Date 01/01/2018
4 |Requirements 01/01/2018 1 Week 01/07/2018 Il
5 |Draft 01/08/2018 1 Week 01/14/2018
6 |Implementation  01/15/2018 1 Week 01/21/2018
7 |Inspection 01/22/2018 3 Days 01/24/2018
8 [servicing 01/25/2018 2 Days 01/26/2018
9 |Release 01/27/2018 2 Days 01/28/2018
10

24
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3. step:

Format your data. Right-click that date and select "Format cell”. In
"Numbers” select the desired option in the date section. Next, change the
order by clicking on "Home" and then in "AB" select the option to rotate

the text up.

Insert Page Layout Formulas Data Review View Add-ins MIO LIBRARY
< - =
B 3‘ S Calibri A =E=E%- BwepTe Text
i ‘[ Copy -
aste v v | By~ == e B - |2 -
< ¥ Format Painter LR ik Y- A+ === =3 £ Merge & Center %
Clipboard £l Font I Alignment Num
E3 b fx 1stJan
A B .2 D Picaibi +[11 <A A -9 0 B
> BI=D-A-H-4R
3 I‘I’asks StartDate Duration  End Date Act tan
4 Requirements 01/01/2018 1 Week 01/07/2018 % Cut
5 VDraft 01/08/2018 1 Week 01/14/2018 Ed Copy
6 Implementation 01/15/2018 1 Week 01/21/2018 ‘D Paste Options:
7 Inspection 01/22/2018 3 Days 01/24/2018 =
8 Servicing 01/25/2018 2 Days 01/26/2018 -
9 Release 01/27/2018 2 Days 01/28/2018 Paste Special...
10 £ Smart Lookup
L [nsert
12 )
1 rele
13 Delete...
14 Clear Coptents
12 2] Quick Analysis
16 Filter »
17 5
Sort »
18
19 1 N Insert Comment
P
20 [ Format Cells...
21 Pick From Drop-down List...
2 Define Name...
23 =
2 &, Link
H &=
File O Inset  Pagelayout  Formulas  Data  Review  View  Add-ins  MIOLIBRARY  Offi
e -
y, b cut Calibri [ A A 2 Wrap Text Text
P;E?ﬂcopyv » Angle Counterclockwis [l
aste v v ~ Angle Counterclockwise .
3 # Foomat Paintes | © 1 ¥ s S %
Angle Clockwise
Clipboard e Font a Number
Vertical Text
E3 v fe 1stJan. 14 Rotate Text Up
[ A B c D E 18 Rotate Text Down |
1 ¥ Format Cell Alignment
2
3 |Tasks Start Date  Duration  End Date istJan.|
4 |Requirements 01/01/2018 1 Week 01/07/2018
5 |Draft 01/08/2018 1 Week 01/14/2018
6 vlmplementation 01/15/2018 1 Week 01/21/2018
7 |Inspection 01/22/2018 3 Days 01/24/2018
8 |Servicing 01/25/2018 2 Days 01/26/2018
9 |Release 01/27/2018 2 Days 01/28/2018
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4. step:
Click on the date you just created with the left mouse button. Afterward,

click on the bottom left corner and drag the cursor down until you have
the correct number of days for the duration of your project.

& £ | sty
A B c ) E F G H ! ) K L M
1
2
3 [rasks StartDate Duration End Date 3
4 |Requirement ts  01/01/2018 1 Week 01/07/2018 Sth Jon.
5 Oraft 01/08/2018 1 Week 01/14/2018
6 /Implementation 01/15/2018 1 Week 01/21/2018
7 Inspection 01/22/2018 3 Days 01/24/2018
8 |servicing 01/25/2018 2 Days 01/26/2018
9 [Release 01/27/2018 2 Days 01/28/2018

5. step:
Slect the complete time span by selecting the top cells (E, F, ...) and reduc-
ing the size of these individual fields. To do so, click on the vertical lines
between the selected cells and drag them to the desired size.

u M s a A |
5 s H H 5 H s H £ £ H - 5 £
£ 2 2 £ § E T £ £ £ £ = £ =

J 2 & | g A ] ] & g g 5 g H H

5 .

6

8 = =

A ] G ) E[F G|H 1 J|K LIMNOP QR S|T U V W X|Y Z AAABACAD AE AF AGAH

3 |Tasks StartDate  Duration  End Date

4 Requirements  01/01/2018 1Wesk  01/07/2018
S Draft 01/08/2018 1 Week 01/14/2018
6 Imy on  01/15/2018 1 Week 01/21/2018
7 ins; 01/22/2018 3 Days 01/24/2018
8 01/25/2018 208ys_01/26/2018
9 01/27/2018 20ays  01/28/2018
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6. step:

Add conditional formatting. Select the relevant cells that are to receive this

formatting. In “"Home" click on “Conditional formatting” and on "New
rule”. Select an customized formula as your rule type.

Afdws  MOUBRARY  OfceSpy  Team

o X .= )
L Caon Suoe AW =g & PLwsle Gerend T 4

J Gacopy - - 1) ! !
Fagt orsasl ek e 53R B O T v 7 ]
A Farmtpret | BT Y dc =S = HE Eveeacon - (Fox 0 (o | Eadow fom s

Zipdeard “ Fers . Aigragnt 3 e
@ - 1.
Al A £ (|l EUF GIHIL alxlminio plaliR sTTlu wiwl X v 7 AR IXCIAD AE LS IAG A
1

i

Y StutOuly  Curatien  (ndOute 2
4 [Requitements  OLAO1/2018 1 weck oo/ e |
3 |onat LRSS 1 Week i/3afan
8 [enplomentstise  O1/35/201% 1 Week o/ oy
7 |espornion QIf22/263% 3 Days [RUEEIASIE
# [seevieing Q1252013 2 Days 032012015
9 |rateate OU2TI2018 2 D3ys 03/28/2918
0

> EX G Catbri 1 KA E=E % | Bweplet General -
— E2 Copy * =
e D BapL === == Eue . T .m v g gtonatianal Format 2| [T 0 o
e pa | BT D A = 3= ES Merge & Contor % ‘B K = By Checkcall
Cipboare . Fant ) Alignnent 0 Number W
.| Hightight Cells Rules *
X7 - s ]
d A ] 3 D (EFIGH[I J|K LMNOPQRSTUV [LJ, lopfBatiom Rukes g | FiaG M
1
2 ‘ Data Bars 4
) = 3585
i 35|88
h [B] cotor scales ‘EE|EE
3 |Tasks StartDate Duration ndDate 1 SERR
4 [Requirements  01/01/2018 1 Week  01/07/2018 [ seonsess ,
5 |oraft 01/03/2013 1Week  01/14/2018 =
6 |Imglementation  01/15/2013 1 Week 01/21/2018 L tow Ruls..
7 |inspection 03/22/2018 3 Days 01/24/2018 O [ Clearhuses ,
8 |servicing 01/25/2018 2 Days 01/26/2018 B Manage Rues
5 |Relesse 01/27/2018 2 Days 01/26/2018
10

Select a Rule Type:

}Lj 4 [nomal Bad

~ Format all cells based on their values

= Format only cells that contain

= Format only top or bottom ranked values

= Format only values that are above or below average
= Format only unique or duplicate values

= Use a formula to determine which celis to format

Edit tpdule Description:

ﬁnﬁvalueswh«eﬂﬁsfomubism

No Format Set
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7. step:

Enter an “AND formula” with two conditions. Begin with “=and( “. Now
click on the cell containing the first date of your headers. The formula will
appear in the editing bar. For example, for Cell D3 (=$D$3). This value in
this cell has to be equal to or higher than the start date. Therefore, enter
">="and then click on the cell that contains the start date. The formula of
this cell will now be entered. Now enter ;" and repeat the procedure for
the end date. Click on the cell containing the first date of the headers. The
formula of this cell should appear. It will have to be smaller than the end
date. Therefore, enter “<="in the formula and click on the cell containing
the end date. To complete the formula, close the bracket and delete the

first, fourth, fifth and eighth dollar symbol (“$") from this formula.

Select a Rule Type:

= Format all cells based on their values
= Format only cells that contain
= Format only top or bottom ranked values

= Format only values that are above or below average
~ Format only unique or duplicate values
= Use a formula to determine which cells to format

Edit the Rule Description:

Format values where this formula is true:

=und(ES3> =SB4;ES3<=5D4) 3

Preview: No Format Set Format...

o0 || cn oK Cancel

28



uh
empower ™

8. step:
Set a format that reflects the formula by clicking on “Format” and select-
ing a color you wish to display the bars of your Gantt chart. You have now
created a Gantt chart following simple steps. It also has the ability to dy-
namically adapt to changes and additions automatically.

¢
H

Book1 - Excel

iew Add-ins MIO LIBRARY OfficeSpy Team Q Tell me what you want to do

A"j ,‘Ez:’y i Calibri M AN == | EWepTet General - ‘PZ’] [_‘,‘J Normal Bat
Paste. o rormatpainter B I U~ | EH~ |2 A S==|EE EMegesiCener - (T % 0 (B3 é?;‘i?i?n";‘. it | Crieckcell| I
Clipboard o Font T Alignment ". Number
w29 £
| A [ [ D (E|F|GH I |J KL MNOP QR[S TU VWX Y|Z AAABACAD AE AFAGAH
1 {
2]
§EEEEEEEEEERREERRREERERRARES
SRR |2 IlE R IE B lE (5|5 IEIE|E1E |8 RIS 61555 (5 |8
3 Tasks StartDate Duration EndDate 2 & 5 T HEFLXF 2SS0 2225 Z2A2RJNQILR[IER]R
4 |Requirements 01/01/2018 1 Week 01/07/2018|
5 |Draft 01/08/2018 1 Week 01/14/2018
6 |Implementation  01/15/2018 1 Week 01/21/2018
7 Inspection 01/22/2018 3 Days 01/24/2018
8 |Servicing 01/25/2018 2 Days 01/26/2018
9 Release 01/27/2018 2 Days 01/28/2018
10

Insert Gantt chart in PowerPoint

Then copy the entire Excel table into your desired PowerPoint presentation: Select
the table, open the context menu with a right click and click "Copy". In your Pow-
erPoint presentation, select the desired slide, select a content placeholder and
choose "Insert" from the context menu.
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Does this sound too complicated?

Create Gantt charts directly in PowerPoint

Want to create a Gantt charts easi-
er and faster? With our product
empower® charts, we at Made in
Office have made it possible to
create elegant Gantt charts directly
in PowerPoint, via drag & drop and
in your corporate design. Make
sure to read more about our pow-
erful charting and layout software.
Manually creating Gantt charts for
project plans and timelines in Pow-
erPoint is time-consuming and te-
dious. With empower® charts you
can create your Gantt charts in a
few minutes and with a few clicks,
automatically. For example, you
can show school vacations or struc-
ture your tasks in phases and col-
lapse them when needed.

=B Gantt Chart

Gantt Chart

Timeline
From To

22.02.2021 29.05.2021

Header Settings
Use recommended Header Settings m On

o EE

e 0 - L.
V| Month Qv-_lﬁiv
V| Wee &vm 49 50 52 @V

)
<3~ i ik e R ek e s a5

Maximum header font size
12 hd

Regional settings (headers and date format):
English (United States) v

Items

; Show Phases Q On

Phases Rows per phase
2 3

v ~

Notes Area

Show first column (] Off

£ Show second column ® Off
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Link PPT charts with Excel &
automatically update
PowerPoint Excel links

Do you need to link Excel tables to your PowerPoint charts in your next re-
port or do you need to update the links? Our short video tutorial will show
you how to insert an Excel chart into PowerPoint. We will also show you how
te automatically update chart values e.g. for quarterly figures. For example,
With, 50 charts in PowerPoint, manual updates can be very labor-intensive.
UsSinghour instructions, updating a PowerPoint Excel link automatically will no
longerbe o problem.
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Guide: Insert Excel table in
PowerPoint presentation

1. Open Excel Data.

2. Select table and click insert and then

File  Home

hutosave @ 50) ] D~

chart.

g v

Fage Layout

st Draw Fan MIOLBRARY  Help

b -A W
Bry-.|M-[6-A- b=
A s c o £ v s " | N
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2 |pata 12 o 3 S 2
i |Data2 34 as 96 7 23 65/
4 Data3 s 7 5 « u 3
5 |Datad 10 2 7t 1 prt u
o Datas 5 a . 3 Pt s
7 |Datas 2 s P 2 s 8,
8 &
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2
3
1
1
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"
1
1
S
2
2
)
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File  Home

2 Daa1

3 Data2
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5 Datad
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Draw Add-ins  MIO LIBRARY
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P

Insert Page Layout View
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4. Open PowerPoint presentation.
5. In the Home Ribbon, click on paste.

6. Choose option Use destination Theme and link Data.
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Updates for PowerPoint Excel links

If the data in your Excel file has changed, you have the ability to update your
chart in PowerPoint with a single click. So there is the possibility to link the
diagrams with Excel and thus make work easier.

Under File / Information / Edit Links to Files (PPT 2016) you can also set
an automatic update of the diagrams in PowerPoint.

Please note: Drawbacks at native version

= Links can only be corrected individually
= There are no relative file paths possible

= When you open the presentation, the charts are not updated automatical-
ly by default

= Automatic updating is not always reliable in Office 2016 (for example,
when a link needed to be repaired)

= Existing charts in PowerPoint can not be linked (you must always copy an
Excel chart).

= No possibility for clean separation of data management and visualization
(all diagrams must be additionally available in Excel)

= In older versions of Office, native joins are generally not always stable
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Save resources through automatic
updates for PowerPoint Excel links

All quarterly figures that you have created in Excel can be inserted and auto-
matically updated in PowerPoint. These dynamic reports save you time and
thus money. You do not have to insert Excel values each time, and you avoid
errors when manually editing PowerPoint charts.

These instructions for automatic chart link updating require the empower®
charts add-in for PowerPoint.
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Advantages of empower® when
linking PPT and Excel:

= Update data automatically - changes do not have to be manually trans-
ferred from Excel to PowerPoint

= Intuitive and easy creation of simple links
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Professional formatting for
your PowerPoint charts

Some chart layouts just look better than others. You are probably wondering
why this is so and how you can create a professional chart format yourself. In
the following, you'll learn the basic settings for editing a PowerPoint diagram.
Among other things, you will learn about labeling, the right color scheme and
exciting chart animations.
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Formatting and editing your chart
elements:

Once you have created your chart, you can customize its format and how it's
displayed.

One way to customize your map is to use the Design and Format tabs in the
PowerPoint Ribbon Chart Tools group.

Alternatively, double-clicking on the chart opens the formatting task pane on
the right side of the PowerPoint window. Pay attention to which part of the
map you click on, as the formatting task pane only refers to the selected map
element, such as Format Chart Area, Format Plot Area, or Format Data Series.
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Chart title

You have several options for changing and positioning your title. To change
the position of your title or remove it completely:

1. Click on “Add Chart Element” on the Chart Tools > Design tab.

2. Choose “Chart Title" in the Add Diagram Element menu.

3. Select “None" to remove the title from the map, “Above Diagram” to po-
sition it above the map, or “Center Overlay” to position the title on top of

and centered on the chart.

If you click on “More Title Options...", the Format Chart Title task pane
opens. That task pane also opens when you double-click on the chart title.

You can also click on the large plus (+) symbol next to your map to adjust the
Chart Title.
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Data labels:

Would you like country data to appear on the chart? Here's how:

1. Click on “Add 2. Danach Choose 3. Select "None” to
Chart Element” on “Data Labels”. hide data labels or
the Chart Tools > “Show” to show
Design tab. them.

If you select “More Data Label Options...", the Format Data Labels task pane
opens with additional data label configuration options. You can also click on
the large plus (+) symbol next to your map to adjust Data Labels.

More options for data labels

= “Label Options": Name, Category, Value, and what separator to use be-
tween them.

= "Number”: Category (Number, Currency, Percent, etc.) or a custom format.
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Color scheme of charts:

Before you change colors, consider
carefully what color scheme to use,
so that your map harmonizes with
the entire presentation.

You can adjust your map's colors in
several ways:

= On the Chart Tools > Design
tab, click the “Change Colors”
button.

= On the Format Data Series task
pane, choose Series Options >
Series Color.

» elect individual countries, right-
click and choose “Fill” and op-
tionally "Outline”.

You can define a color scheme for
all regions that you enter in your
Excel table. Remember, when ad-
justing individual countries’ colors,
use colors that fit your overall color
scheme and complement the rest
of your map. To color your map's
background, click on the outer
edge of the map to open the For-
mat Chart Area task pane to adjust
“Fill” and “Line”. You can also
right-click on the map edge to
open a popup menu with the same
options.
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Text color, size, and effects:

You can change title and label text formatting by:

» double-clicking on the title, or
» right-clicking on the title or legend, or in the task panel

Right-click or double-click on the title and label to change fonts, sizes, colors.

Right-clicking gives you the most options. The task pane controls special ef-
fects like text fill, outline, shadows, and more.
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How to be special: Create anima-
tions in PowerPoint

You can animate your map. Animation might be suitable if you want to
demonstrate the evolution of different values.

Here is how:

1. Insert the video into a slide. Click "Insert" and select "chart".
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2. PowerPoint animations can only be inserted from the "Input" area. If an
animation is to disappear after a certain time, then you must insert a new
animation from the "Output" area. This is explained in more detail below
for the case of the speech bubble.

3. Click the speech bubble to place it where you want it in the chart.

4. You want the speech bubble to fly into the chart. Click the speech bubble
and select "Entrance" under Animations and then "Fly in". Now the effect
appears in the Animation panel.
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empower your brand &
productivity in PowerPoint

PowerPoint offers you much more than you knew before. Why not take a
look at empower® charts - the PowerPoint add-in that facilitates chart crea-
tion far beyond standard PowerPoint functions. With empower® charts you
can create meaningful PowerPoint charts in no time - not only bar charts and
line charts, but also elegant Gantt charts and easy-to-understand waterfall or
Marimekko charts.

Do you want to be efficient and save time when creating diagrams?
The PowerPoint add-in empower® has already helped companies such as
Continental AG or Bayer to achieve more efficiency creating meaningful dia-
grams.

g (2 9,

easy efficient brand compliant
Creating complex charts is one of 40% of your time working with Most charts in presentations don't
the biggest time wasters in PowerPoint is spent formatting. comply with brand-design
PowerPoint. With empower® With empower® productivity guidelines. With predefined charts
charts, you can almost tools you can format charts in no and custom Color Pickers, you can
automatically create charts like time, link them with Excel files, ensure every chart is brand
Gantts and Waterfalls. and add Arrows and Lines. compliant.
Learn More — Learn More — Learn More —

You can get all information by contacting us. We can present empower®
charts to you in an online demo or provide a test version of empower®.
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https://www.empowersuite.com/en/products/empower-charts
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empower GmbH
KoInTurm

Im Mediapark 8
50670 Kaln

Telefon: +49 22199 3785 -0
+44 20 39365433
+1 800 6570270
E-Mail: request@empowersuite.com
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